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TRACKING AND MANAGING 

DOCUMENT CHANGES 
 When two or more people collaborate on a 

document, one person usually creates and owns the 
document and the others review it. 
 

 Reviewers can turn on the Track Changes feature 
so that the revisions they make to the document are 
recorded without the original text being lost. 
 

 Changed text shows in a different color and 
underlined. 
 

 Deleted text shows up in a comment balloon at the 
margin of the document and displays a vertical line 
in the margin to the left of any changed text to help 
you locate changes in the document. 
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TRACKING AND MANAGING 

DOCUMENT CHANGES (CONT.) 

 Follow these steps: 

1. Click the View tab, click the Track Changes 

button (Tracking section). 

 Any changes that you make will now be tracked. 
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PRACTICE #1 

1. Run MS-Word 
 

2. Open the file named OriginalExcelLP 

located in the teacher’s course wiki space. 
 

3. Activate the Track Changes feature. 

button. 
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TRACKING AND MANAGING 

DOCUMENT CHANGES (CONT.) 

 If the revision marks are distracting, you can 

track changes without showing them on the 

screen. 

 To hide revision marks: 

 Click the down arrow to the right of the Balloons button and 

then click Final. 
 

 To show the revision marks again: 

 Click the down arrow to the right of the Balloons button and 

then click Final Showing Markup. 
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TRACKING AND MANAGING 

DOCUMENT CHANGES (CONT.) 

 Accept Changes 

 You can use this feature to incorporate a change 

into the document. 

 A change can be accepted individually by right-

clicking on the changed text and then clicking 

Accept Insertion. 
 

 However, if all changes need to be accepted at 

once, then click the arrow to the right of the 

Accept Changes button and click Accept All 

Changes in Document. 
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TRACKING AND MANAGING 

DOCUMENT CHANGES (CONT.) 

 Reject Changes 

 You can use this feature to refuse a change in the 

document. 

 A change can be rejected individually by right-

clicking on the changed text and then clicking 

Reject  Insertion. 
 

 However, if all changes need to be accepted at 

once, then click the arrow to the right of the 

Reject Changes button and click Reject All 

Changes in Document. 
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PRACTICE #2 

1. Under the MATERIALS section add 

Practice files. 
 

2. Replace the word OBJECTIVE with GOAL. 
 

3. Accept the practice files changes. 

4. Reject any other changes. 
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ADDING COMMENTS 

 Allows to insert notes or comments, to ask 

questions or explain suggested edits. 
 

 To insert a comment: 

1. Select the text to comment on. 

2. Click the Insert Comment button on the Review 

tab and type your comment. 
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PROTECTING A DOCUMENT 

WITH A PASSWORD 

 Allows certain people to be able to open a document. 
 

 Follow these steps: 

1. Click the Office button, point to Prepare, and click Encrypt 

Document. 
 

2. In the Encrypt Document dialog box, in the Password box, 

type a password, and then click OK. 
 

3. In the Confirm Password dialog box, in the Reenter 

password box, type the password again, and then click OK. 
 

4. To save the password, save the file.  
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PRACTICE #3 

1. In the Vocabulary section, add a comment 

indicating some of the terms that will be 

discussed need to be included here. 

2. Add a Password to open the document 

called TeacherLP. 
 

3. Save the document as 

PasswordTeacherLP. 
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COMPARING AND MERGING 

DOCUMENTS 
 Allows to compare several versions of the same 

document. 
 

 Word shows the differences as tracked changes. 
 

 If several reviewers return their changes and 
comments in separate documents, these changes 
can all be merged into a single document for 
easier review. 
 

 When you compare versions of a document, you 
see the reviewer’s changes in revision marks even 
if the reviewers did not track their changes as they 
edited. 
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COMPARING AND MERGING 

DOCUMENTS (CONT.) 

 Follow these steps: 

1. Open the original document that was sent for review. 
 

2. In the Review tab, click Compare button, and then click 

Combine.  The Combine Documents dialog box appears. 
 

3. Under Original document, click the name of the 

document into which you want to combine the changes 

from multiple sources. If you don't see the document in 

the list, click Browse for Original  
 

4. Under Revised document, browse for the document that 

contains the changes by one of the reviewers. 
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COMPARING AND MERGING 

DOCUMENTS (CONT.) 
5. Click More. 

 

6. Under Show changes, select the options for what you 

want to compare in the documents.  You should generally 

leave this at the word level. 
 

7. Under Show changes in, 

 Click Original document if you want to have the original document 

as the combination of both documents. 

 Click Revised document if you want to have the revised document 

as the combination of both documents. 

 Click New document if you want to have a new document as the 

combination of both documents. 
 

8. Click OK. 
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PRACTICE #4 

1. Use the files JoeRevisionLP and 

MariaRevisionLP to merge their changes 

with your document. 
 

2. Accept all the changes. 
 

3. Save your document as [document 

name]MergedRevisions, where [document 

name is the name that you used to save the 

original document to be revised.   
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CONTROL A DOCUMENT’S 

DESIGN WITH A TEMPLATE 

 A template is a file that stores text, 

character and paragraph styles, page 

formatting, and macros for use as a pattern 

in creating other documents. 
 

 MS-Word provides with a list of different 

templates to use for different occasions. 
 

 In addition, MS-Word allows users to 

customize existing templates. 
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CONTROL A DOCUMENT’S DESIGN 

WITH A TEMPLATE (CONT.) 

 Using an existing template: 

1. Click the File tab and click New.  The New document 

dialog box appears on the left side of the screen. 
 

2. On the Available Templates group, click Sample 

templates.  A list of existing Microsoft templates will 

appear on the right pane. 
 

3. Browse through different templates until you find a 

template that suits you and select it. 
 

4. Click OK.  A new document is created from the template 
 

5. Provide the necessary information. 
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PRACTICE #5 

1. Use the Oriel Letter template to send a 

letter to a peer educator that you want to 

invite as a speaker for one of your classes. 
 

2. Fill out the necessary information (you can 

use fictitious names if desired). 
 

3. Save your document as 

SpeakerLetterSP2010.   
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CONTROL A DOCUMENT’S DESIGN 

WITH A TEMPLATE (CONT.) 

 Saving Existing Template as a Different 
Template: 

1. Do steps 1-5 under Using an Existing Template. 
 

2. Click the Office button, point to Save As and click Word 
Template.  The Save As window appears. 
 

3. In the Save as type box, select Document Template 
(*.dotx).  Browse until you find the location where you 
want to save it. 
 

4. Type a name for your template. 
 

5. Click Save. 
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PRACTICE #6 

1. Open the Template called Urban Report 
 

2. Change the font of the title section to 

Century Gothic. 
 

3. Change the date to italics. 
 

4. Save this file as a Template under the name 

of MyUrbanReport. 
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CREATING A BIBLIOGRAPHY 

 A bibliography is a list of sources, usually 

placed at the end of a document, that you 

consulted or cited in creating the document. 
 

 In Microsoft Office Word, you can 

automatically generate a bibliography 

based on the source information that you 

provide for the document. 
 

 Each time that you create a new source, 

the source information is saved on your 

computer, so that you can find and use any 

source you have created. 



ADVANCED WORD AND 

INTEGRATED MS-OFFICE 22 

CREATING A BIBLIOGRAPHY 

 When creating a bibliography you must: 
 

 Add new sources and citations to your 

document. 
 

 Edit the Citation Placeholder 
 

 Generate the Bibliography 
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ADDING NEW SOURCES/CITATIONS 

 When you add a new citation to a 

document, you also create a new source 

that will appear in the bibliography. 
 

 Follow these steps: 
 

1. On the References tab, in the Citations & 

Bibliography group, click the arrow next to 

Style. 
 

2. Click the style that you want to use for the 

citation and source. 

 For example, social sciences documents usually use 

the MLA or APA styles for citations and sources. 
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ADDING NEW SOURCES/CITATIONS 

3. Click at the end of the sentence or phrase 

that you want to cite. 
 

4. On the References tab, in the Citations & 

Bibliography group, click Insert Citation. 

5. Do one of the following: 

 To add the source information, click Add New 

Source.  

 To add a placeholder, so that you can create a 

citation and fill in the source information later, click 

Add new placeholder. A question mark appears 

next to placeholder sources in Source Manager.  
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ADDING NEW SOURCES/CITATIONS 

6. Begin to fill in the source information by 

clicking the arrow next to Type of source. 

For example, your source might be a book, 

a report, or a Web site. 
 

7. Fill in the bibliography information for the 

source. To add more information about a 

source, click the Show All Bibliography 

Fields check box.  
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GENERATING BIBLIOGRAPHY 

 Once you have all your sources, then 

you can create a bibliography 

 The cursor needs to be at the very end of 

the document before doing it. 
 

 On the References tab, click 

Bibliography. 
 

 Click on which style of bibliography you 

would like to use. 
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PRACTICE #6.5 

1. In a new document, create new sources 

from the sources that you would 

recommend your students. 
 

2. Type one paragraph about your own topic.  

Insert citations from your sources as you 

see fit. 
 

3. Generate a bibliography at the end of the 

document.  
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MAIL MERGE 

 You use mail merge when you want 
to create a set of documents that are 
essentially the same but where each 
document contains unique elements. 

 For example, in a letter that announces 
a new product… 
 

 your company logo and the text about 
the product will appear in each letter… 
 

 …and the address and greeting line will 
be different in each letter. 
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MAIL MERGE 

 There are five main steps in the mail 
merge process: 
 

1. Setup the main document 
 

2. Connect the document to a data 
source. 

 

3. Refine the list of recipients or items 
 

4. Add placeholders (mail merge fields) to 
the document. 
 

5. Preview and complete the merge. 
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MAIL MERGE – START THE MM 

PROCESS 

 Follow these steps (make sure you 
have a blank document): 
 

 In the Start Mail Merge group on the 
Mailings tab, click Start Mail Merge 
 

 Click Step by Step Mail Merge 
Wizard. The Mail Merge task pane 
opens. 

 By using hyperlinks in the task pane, you 
navigate through the mail-merge process. 
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MAIL MERGE – SETUP THE MAIN DOC 

 The main document is the 
document that you start with.  
It's the model for all of the 
merged documents that you 
eventually create. 
 

1. Choose the type of document that 
you want to merge information 
into (e-mail, letters, envelopes, 
directory, or labels). 
 

2. Click Next. 

http://office.microsoft.com/en-us/help/HA011095491033.aspx
http://office.microsoft.com/en-us/help/HA011095491033.aspx
http://office.microsoft.com/en-us/help/HA011095491033.aspx
http://office.microsoft.com/en-us/help/HA011095491033.aspx
http://office.microsoft.com/en-us/help/HA011095491033.aspx
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MAIL MERGE – SETUP THE MAIN DOC 

 If your main document (called 
the starting document in the 
task pane) is already open, or 
you are starting with a blank 
document, you can click Use 
the current document. 
 

 Otherwise, click Start from a 
template or Start from 
existing document, and then 
locate the template or 
document that you want to use. 

 Click Next 
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MAIL MERGE – CONNECT THE DOC TO 

A DATA SOURCE 

 To merge unique information into your 
main document, you must connect to (or 
create and connect to) the data file where 
the unique information is stored. 
 

 If you don't want to use all the data in the 
file in your merge, you can choose the 
records that you want to use. 
 

 In this step in the mail-merge process, 
you connect to the data file where the 
unique information that you want to 
merge into your documents is stored. 
 

http://office.microsoft.com/en-us/help/HA011095501033.aspx
http://office.microsoft.com/en-us/help/HA011095501033.aspx
http://office.microsoft.com/en-us/help/HA011095501033.aspx
http://office.microsoft.com/en-us/help/HA011095501033.aspx
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MAIL MERGE – CONNECT THE DOC TO 

A DATA SOURCE 

 Existing lists for contacts could 
be located in Excel spreadsheets 
or Access databases and may be 
selected by choosing Use an 
existing list. 
 

 If you have a contact list from 
Outlook, it can be imported for 
the mail merge process by typing 
Select from Outlook Contacts. 
 

 If no contact list exists, you may 
create a new list by selecting 
Type a new list 
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MAIL MERGE – CONNECT THE DOC TO 

A DATA SOURCE 

 Just because you connect to a certain data file doesn't mean that 

you have to merge information from all the records (rows) in that 

data file into your main document. 
 

 After you connect to the data file that you want to use or create a 

new date file, the Mail Merge Recipients dialog box opens. 
 

 You can select a subset of records for your mail merge by sorting 

or filtering the list 
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PRACTICE #7 

1. Use Word Mail merge feature and either 

use Median Merge Letter template. 
 

2. Create a new contact list, with five names 

(real or fictional) with city, state, zip, and 

phone numbers. 
 

3. Save the contact list as MyContacts in your 

flash drive (you may also attempt to bring 

your outlook contacts if any).  
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MAIL MERGE – REFINE THE LIST OF 

RECIPIENTS OR ITEMS 

 Click Edit Recipient List (either from the 

Mailing Ribbon or from the Wizard task 

pane).  The Mail Merge Recipients dialog 

box will appear.  Click Next when done. 
 

 Some of the available options include: 

 Sort records  Click the column heading of the 

item that you want to sort by. 

 Filter records  This is useful if the list contains 

records that you know you don't want to see or 

include in the merge. 
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MAIL MERGE – ADDING MAIL MERGE 

FIELDS TO THE DOC 

 After you connect your main document to a 

data file, you are ready to type the text of 

the document and add placeholders that 

indicate where the unique information will 

appear in each copy of the document. 
 

 To make sure that Word can find a column 

in your data file that corresponds to every 

address or greeting element, you may need 

to map the mail merge fields in Word to the 

columns in your data file. 
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MAIL MERGE – ADDING MAIL MERGE 

FIELDS TO THE DOC 

 To map the fields: click Match Fields in the 

Write & Insert Fields group of the 

Mailings tab. 

 The elements of an address and greeting are 

listed on the left. Column headings from your 

data file are listed on the right. 
 

 Word searches for the column that matches 

each element. 
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MAIL MERGE – ADDING MAIL MERGE 

FIELDS TO THE DOC 

 In the list on the right, you can select the 

column from your data file that matches the 

element on the left. 
 

 Your mail merge document doesn't need to 

use every field. 
 

 If you add a field that does not contain data 

from your data file, it will appear in the 

merged document as an empty 

placeholder — usually a blank line or a 

hidden field.  
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MAIL MERGE – ADDING MAIL MERGE 

FIELDS TO THE DOC 

 MM Fields are placeholders that you insert into the main 

document at locations where you want unique 

information to appear. 

 For example, you can click the Greeting line link in the task 

pane to add fields near the top of a new product letter, so that 

each recipient's letter contains a personalized greeting. 
 

 Fields appear in your document within chevrons, for example, 

«AddressBlock». 
 

 If your main document is still blank, type the information 

that will appear in each copy. Then, add fields by 

clicking the hyperlinks in the task pane.  Click Next 

when finished adding all the fields.  
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MAIL MERGE – PREVIEW AND MERGE 

 To preview, do any of the 

following: 

1. Page through each merged 

document by using the next and 

previous buttons in the task pane. 

 

2. Preview a specific document by 

clicking Find a recipient. 

 

3. Click Exclude this recipient if you 

realize you don't want to include 

the record that you are looking at. 
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MAIL MERGE – PREVIEW AND MERGE 

4. Click Edit recipient list to open the Mail Merge 

Recipients dialog box, where you can filter the 

list if you see records that you don't want to 

include. 

5. Click Previous at the bottom of the task pane to 

go back a step or two if you need to make other 

changes.  
 

6. When you are satisfied with the merge results, 

click Next at the bottom of the task pane. 
 

7. What you do now depends on what type of 

document you're creating. If you are merging 

letters, you can print the letters or modify them 

individually. If you choose to modify the letters, 

Word saves them all to a single file, with one 

letter per page. 
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PRACTICE #8 

1. Preview your merge 
 

2. Click  Edit individual letters… to proceed 

with the merge without printing them right 

away.  Another document is created with 

each letter. 
 

3. Edit and save your work as necessary. 
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MACROS 

 You can automate tasks with a macro for those 

tasks you perform repeatedly in Microsoft Word. 
 

 A macro is a series of commands that is stored in a 

Microsoft Visual Basic module and can be run 

whenever you need to perform the task. 
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RECORDING A MACRO 

 Follow these steps: 
 

1. On the Developer tab, click Record Macro. 
 

2. In the Macro name box, enter a name for the macro. 

 Note: 

 The first character of the macro name must be a letter. 

 Other characters can be letters, numbers, or underscore 

characters. 

 Spaces are not allowed in a macro name; an underscore 

character works well as a word separator. 

3. In the Store macro in box, click the location where you 

want to store the macro (all the documents based on the 

Normal template, or just the current document).  
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RECORDING A MACRO 

 

4. If you want to include a description of the macro, type it in 

the Description box. 
 

5. Optionally, you may assign the macro to a key stroke. 
 

6. Click OK. 
 

7. Record the actions you want for the macro, and then click 

Stop Recording button on the status bar.  
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RUNNING A MACRO 

 Follow these steps: 
 

1. Open the presentation that contains the macro you want 

to run. 
 

2. On the Developer tab, in the Code group, click Macros. 
 

3. In the Macro name box, click the name of the macro that 

you want to run, and then do one of the following:  
 

 If you want to run a macro in a presentation, click Run.  

 If you want to run a macro from a Microsoft Visual Basic 

module, click Edit, and then in Microsoft Visual Basic 

Editor, click Run Sub/UserForm on the toolbar. 

 .  
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PRACTICE #9 
 

1. Open OriginalExcelLP. 

2. Record a Macro called TeacherChangeAllFont.  

The following actions should be recorded. 
 

 Highlight the entire document. 

 Change the font to Garamond 

 Change the font size of the title 

 Run Print preview 
 

 

3. Go to the beginning of the document and run the 

macro. 
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SECURITY WITH MACROS 

 Because macros can contain viruses, be careful 

about running them. 
 

 Take the following precautions: 

 run up-to-date antivirus software on your computer 

 set your macro security level properly 

 use digital signatures 

 maintain a list of trusted publishers. 
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SECURITY WITH MACROS 

 Follow these steps: 

1. On the Developer tab, click Macro Security.  
 

2. Under Macro Settings, decide how you want to handle 

Excel files that contain macros. 
 

 Disable All Macros without Notification: You can’t run macros, 

period. 

 Disable All Macros with Notification: When you open a file with 

macros, you see a security alert panel.  It notifies you that macros 

have been disabled, but gives you the opportunity to enable them 

(Click the Enable Content button). 

 Disable All Macros Except Digitally Signed Macros: Only 

macros that have been certified with a digital signature can be run. 

 Enable All Macros: You can run any macros, period (very risky). 

3. Click OK twice. 
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INTEGRATING MS-OFFICE 

 Opening and Displaying Multiple Software 

Simultaneously 

1. Open the first program. 

2. Minimize the first program. 

3. Open the second program. 

4. Maximize the first program. 
 

5. Right-click on the taskbar away from the minimized 

versions of the first and second program.  A pop-up 

menu appears. 
 

6. Click Tile Windows Vertically on the pop-up menu.  You 

should now see the two programs displayed on screen 

side by side. 
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INTEGRATING MS-OFFICE 

 Embedding vs. Dynamic Linking 

 The advantage of embedding in this case is that your 

Excel data will be physically stored in your Word 

document. 
 

 Thus, you can use that document in a computer that 

doesn’t have Excel installed. 
 

 However, it takes more disk space, since it has to save 

the spreadsheet data within the Word document. 
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INTEGRATING MS-OFFICE 

 Embedding vs. Dynamic Linking 

 On the other hand, the advantage of a dynamic link in 

this case is that when you change your data in Microsoft 

Excel, it will automatically change the Excel data in your 

Word document. 
 

 Your Word document only possesses a link to the data; 

this data physically resides in an Excel spreadsheet file. 
 

 Therefore, your Word document will take less disk space 

as opposed to using the embedding technique. 
 

 The downside is that if you want to use the document in 

another computer, that computer MUST have Microsoft 

Excel.  
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INTEGRATING MS-OFFICE 

 Embedding a Chart from Excel into Word 

1. In MS Excel, move your mouse pointer over the chart 

until you see the words Chart Area displayed on a small 

box.  

2. Click the mouse on that spot. 

3. In Excel’s Home tab, click Copy. 

4. Switch to Microsoft Word and select the insertion point 

where you want to paste the chart. 

5. In Word’s Home tab, click Paste and then click Paste 

Special. 

6. Select Microsoft Office 2007 Excel Chart Object. 

7. Select Paste. 

8. Click OK. 
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PRACTICE #10 

1. Use the column chart located in NJIT 

Practice 1 and embed the chart after 

discussing the point about teaching 

students about creating and enhancing 

charts. 
 

2. Save your document as 

UsingEmbeddedChart. 
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INTEGRATING MS-OFFICE 

 Creating a Dynamic Link between Excel and Word  

1. In Microsoft Excel, move your mouse pointer over the chart 

until you see the words Chart Area displayed on a small box. 
 

2. Click the mouse on that spot. 
 

3. In Excel’s Home tab, click Copy. 
 

4. Switch to Microsoft Word and select the insertion point, where 

you want to paste the chart. 
 

5. In Word’s Home tab, click Paste and then click Paste Special. 
 

6. Select Microsoft Office Excel 2007 Chart Object. 
 

7. Select Paste Link. 
 

8. Click OK. 
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PRACTICE #11 

1. Use the line chart located in NJIT Practice 

1 and dynamically the chart after discussing 

the point about embedding and linking 

charts. 
 

2. Save your document as 

UsingDLinkedChart. 
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INTEGRATING MS-OFFICE 

• Using Spreadsheets In PowerPoint 
• This allows you to display spreadsheets created in MS-

Excel in your PowerPoint slides and edit them during your 
presentation. 

1. Do the steps for dynamic linking.  However, you will be linking 
this time an Excel worksheet with PowerPoint. 
 

2. After the worksheet has been pasted to the slide in PowerPoint, 
select it. 
 

3. Right-click on the worksheet. 
 

4. In PowerPoint’s Insert tab (Links group) click Action. 
 

5. Under Mouse-Click tab, select Object Action. 
 

6. Select Edit from the drop down list. 
 

7. Click OK. 



ADVANCED WORD AND 

INTEGRATED MS-OFFICE 60 

PRACTICE #12 

1. Open the PowerPoint presentation called 

NJIT Presentation 1. 
 

2. Add a new slide with the Title and Text 

layout.  Its title should be Excel Tips 
 

3. Use the Worksheet from NJIT Practice 1 

and put it in the new slide. 
 

4. Run the presentation and click on the 

worksheet and see what happens. 
 


